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1: How do I password protect my files and folders in Windows?
This utility can also be used to compress and password protect files. Windows Vista and Windows 7 users - Windows
Vista and Windows 7 also include a compression utility. However, password protection for the compressed files is not
possible without the use of a third-party software program.

Twitter Advertisement Take a second to consider how much sensitive information you have stored on your
computer at this moment. Password protecting your sensitive folders is a basic security step. Read on to learn
how to create a password-protected folder to keep your precious files protected, and sneaky onlookers at bay.
Within this document, copy and paste the following code: FAIL echo Invalid password goto end: In my case, I
will name my file Locker. Double-click the BAT file to create your Locker folder. This is the folder that will
be locked with your password. You should now have a folder and a file named Locker. Place all your sensitive
documents within this Locker folder. A command prompt will open asking if you want to lock your folder.
Input Y and press Enter. Your folder should disappear. This is a natural byproduct of your BAT file. To access
your files again, double-click on your Locker. You will be prompted to enter the password you added when
creating the file. If you enter your password correctly, your Locker folder will reappear again. That means
others who are familiar with this trick may be able to change your password. For the most part, however, this
nifty little trick will add a much needed buffer to your most sensitive local documents! Use it to automate
actions. ZIP Folder Lock While the above trick uses the default Notepad program, you can also both lock and
condense your sensitive documents using a popular desktop program named 7-Zip. Typically used to unzip
folders and extract files , 7-Zip also allows users to password protect their folders. To follow this method, first
download 7-Zip. Once 7-Zip is downloaded and installed, click the start menu and type 7zip. Select the 7-Zip
File Manager option. Then, locate the file or folder you want to protect, click on it, and click the Add option at
the top of the window. Next, enter your new password in the Encryption section. Now that you have your
zipped file, delete your original folder as keeping it would defeat the purpose of password protecting your new
ZIP file. In the example below, the Sensitive Documents folder will hold my zipped Safe file. Enter your
password and your files will appear in your directory. Here we cover five ways to hide files, folders, even
drives on Windows. Right-click a file or folder or your choice and select Properties. Check the Hidden option
beside Attributes. Click Apply and then OK. Your file or folder should now disappear. To view your folder
again, click on the View tab of your Windows 10 file manager. In the following File Options window, click on
the View tab. Finally, click on the option labeled Show hidden files, folders, and drives under Hidden files and
folders. You should now be able to view your file or folder. No matter which you pick, you can rest assured
that your previous sensitive documents are safe under an additional layer of protection not enabled by default
on your PC. Sometimes, all it takes is a password lock to prevent theft. That applies to the virtual world as
much it does to the real world. Concerned about malware, ransomware, viruses, and intruders through your
firewalls? Want to back up vital data? Just confused about it all?
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2: Set a password to help protect your Outlook information - Outlook
Fortunately, in Windows 10, you can tuck those unmentionable plans or files in a secret folder that is password
protected, and you can do it without buying any additional software.

For the simple reason that Excel passwords can easily be cracked. This is because Excel uses a very weak
form of encryption that can easily be broken use dictionary attacks and brute force attacks. The older the
version of Excel, the easier it gets to crack the password. In addition to password protecting your Excel file,
you can secure it further by encrypting the entire file. This will safeguard your document if it is stolen from
your computer. Now on to actually adding a password to an Excel file. When using Microsoft Excel, there are
a couple of different ways that you can password protect your spreadsheet or workbook. One of the first and
easiest methods is to password protect the entire sheet or workbook. When a pop-up window appears, select
your options and type in the desired password. Your password can be something random that no one would
ever suspect like 45pQ93S21! In order to remember your password, use a password manager program like
LastPass, which is super secure. You can also read my previous post on securing your data and passwords.
Next, password protect the entire workbook. To do this, click on File, then Save As. When the file-save
window appears, type in your file name, then select the Tools drop down menu. From that menu, select
General Options. This will enable you to password protect the entire workbook and prevent anyone else from
opening it and viewing its contents. At this point, you have two layers of protection: Now, whenever you want
to open that protected Excel file, you will first see a screen like the one below asking for your password. Use
the lastest versions of Excel only: Excel or Excel Use good password policies, which means longer passwords
with different types of characters, numbers and symbols. In addition, try to make the password as random as
possible and use a password manager to keep track of your passwords. Protect your sheets using the Protect
Workbook and Protect Sheet options. Store the file itself in a secure location on your computer like an
encrypted hard drive. Overall, using Excel security with simple password protection is not enough to secure it.
You need better encryption with higher versions of Excel, longer and more random passwords, and extra
encryption on top of the security provided by Excel. If you follow these security practices, your can rest
assured no one will be able to open your Excel file. June 5, by Aseem Kishore. He began blogging in and quit
his job in to blog full-time. He has over 15 years of industry experience in IT and holds several technical
certifications.
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3: How to Password Protect Documents and PDFs with Microsoft Office
If you're worried about forgetting this password, you can always use a password manager. Restricting edits and printing
with Adobe Acrobat Password protecting a PDF document isn't necessarily.

Things to remember when encrypting or password protecting files and folders. Microsoft Windows Vista, 7, 8,
and 10 users Unfortunately, Windows Vista, Windows 7, Windows 8, and Windows 10 do not provide any
features for password protecting files or folders. You need to use a third-party software program to accomplish
this. If you want to encrypt a file or folder, this can be done by following these steps: Select the file or folder
you want to encrypt. Right-click the file or folder and select Properties. On the General tab, click the
Advanced button. Check the box for the "Encrypt contents to secure data" option, then click OK on both
windows. If the "Encrypt contents to secure data" option is not selectable and grayed out or you do not see the
option at all, you likely have a Home edition of Windows, which does not support this feature. It is also
possible that the hard drive where the files are located is not formatted as NTFS , as this is a requirement for
the encryption feature. Microsoft Windows XP Professional users The steps below for encrypting the files on
Windows XP Professional apply to users who are using a computer that has two or more accounts. If you are
using a single account, see the other security solutions section. Right-click the file or folder and click
Properties. Check "Encrypt contents to secure data" option. Click Apply and then OK. You will not be
prompted to enter a password when encrypting a folder in Windows XP Pro. However, other user accounts on
your computer will not have access to files contained in the encrypted folder. Show "Encrypt" on the context
menu The newest version of TweakUI also enables you to show the Encrypt option in the context menu. To do
this, follow the steps below. In the TweakUI window, select Explorer. Click the Sharing tab. Check the box
Make this folder private. Make this folder private is grayed out For this option to work on Microsoft Windows
XP Home edition, you must meet the below requirements. The folder you are attempting to encrypt is your
personal folder. For example, if your name is Bob, you must encrypt the following folder, or a folder within it:
If you want to encrypt folders outside of this folder, see the other security solutions section below. Other
security solutions for protecting your files and folders in Windows File and folders not frequently used - An
easy way to password protect files is to create an archive of the files using a compression tool. When the
archive is created, you can encrypt the contents by specifying a password. This utility can also be used to
compress and password protect files. However, password protection for the compressed files is not possible
without the use of a third-party software program. When a file is compressed, users can still view a listing of
the files in the compressed file. If you want both your file names and the contents to be hidden, move all the
files into a single folder and password protect that folder. File and folders frequently used or accessed If you
need to password protect or encrypt data you frequently use, you need to install a third-party program that
allows you to protect your files and folders. Below are some free and commercial solutions. AxCrypt - An
excellent free encryption utility that enables users to encrypt all files within a folder and not allow those files
to be viewed unless a passphrase password is known. Folder Guard - A commercial version of a password
protection software that enables you to password protect files, folders, and other Windows resources. Open a
search for more solutions to password protect files and folders. There are numerous tools, utilities, and
instructions for how to break encryption and passwords on files. However, the protection methods listed above
will protect your files from the majority of users who may encounter them. If you are working with really
sensitive data, we suggest a commercial product for protecting your files and data. Even though a file or folder
may be password protected, it still can be deleted unless the program supports the ability to protect files from
being deleted. Always remember to backup all your files, even those protected by passwords. Thus, it is
important to backup a copy of the non-password protected files or folders, just in case.
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4: 3 Ways to Password Protect Your Windows Computer - wikiHow
Below are several free ways to password protect a PDF file, a pretty easy thing to do no matter which way you go about
it. There are software programs you can download for encrypting the PDF but some are online services that work in your
web browser.

Advertisement An encrypted USB flash drive is the safest way to carry sensitive files. Unfortunately, you
cannot password protect your entire USB flash drive, like you can password protect your PC or phone. Secure
tools all work with encryption. Unless you want to invest in an encrypted flash drive with hardware
encryption, you can use freeware applications to achieve a similar level of USB protection. This article
summarizes the easiest ways to password protect or encrypt files and folders on a USB flash drive. Create an
Encrypted Partition Many tools can encrypt and password protect your data. Most, however, require
Administrator rights to run on any given computer. Rohos Mini Drive, however, works whether or not you
possess Administrator rights on the target computer. The free edition can create a hidden, encrypted, and
password-protected partition of up to 8GB on your USB flash drive. The tool uses automatic on-the-fly
encryption with AES bit key length. Subsequently, you can access the protected data anywhere. This will
create a password-protected and encrypted container on your external drive. You can open the protected
container by clicking the Rohos Mini. After entering the password, the Rohos disk will mount as a separate
drive and you can access it via File Explorer. To close your Rohos partition, right-click the Rohos icon in the
Windows Taskbar notification area and select Disconnect. Rohos Mini Drive 2. VeryCrypt does require
Administrator rights to operate. It uses on-the-fly AES bit encryption. The free version is limited to drive sizes
of 2 GB. Like Rohos Mini Drive, it can create a virtual encrypted disk that mounts like a real disk, but you can
also encrypt entire partitions or storage devices. When you launch the portable app, it will show you all
available drive letters. Choose one and click Create Volume. In the next step, you can choose from a Standard
or a Hidden VeraCrypt volume. Using a hidden volume reduces the risk that someone forces you to reveal
your password. But how often have you actually formatted a drive and did you ever wonder what the various
options mean? Read More if you want to create a Hidden VeraCrypt volume. In the next window, click Select
Device, choose your removable disk, confirm with OK, and click Next. VeryCrypt will warn that you should
have a backup of the data, in case something goes wrong during encryption. Now select the Encryption and
Hash Algorithm; you can go with the default settings. Now you get to set your Volume Password. In the next
step, your random mouse movements will determine the cryptographic strength of the encryption. Now choose
your Wipe Mode; the more wipes, the safer. In the final window, click Encrypt to start the encryption. An
alternative to VeraCrypt Portable is Toucan , a portable app that lets you sync, backup, and secure your files. It
does not require installation and will work with Windows, Linux, and Mac without admin rights. To set it up,
however, you have to run an EXE file from the flash drive you wish to encrypt. Running the EXE file will
launch a command prompt and browser window. Logging in mounts the Safe Zone. Any files you copy into
the SafeZone are automatically encrypted. Note that closing the command prompt window will close your
Safe Zone session. The easiest way to completely remove SecurStick from your flash drive is to format the
drive. Note that this will delete all files stored on it, meaning you should back them up. Simply right-click the
drive in Finder, select Encrypt, and add a password. The process starts instantly and can take a few minutes,
depending on the size of your USB stick. You should not use this tool if you intend on using the encrypted
files outside of Linux. Moreover, accessing your encrypted flash drive requires a Cryptsetup installation. Next,
launch Disks from the desktop, look for your flash drive, and select to format the drive or a single partition
with the encryption option. Note that you have to overwrite all existing files. If you use Ubuntu Linux, please
refer to our complete file and folder encryption guide How to Encrypt Files and Folders in Ubuntu How to
Encrypt Files and Folders in Ubuntu Did you know that you can protect your personal files on Linux by
encrypting your files and folders? However, if you shy away from the time-consuming encryption process for
entire folders and need a really quick way to only protect a few selected files, you can simply save those with
a USB password. Many programs, including Word and Excel, allow you to save files with a password. Now
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enter your password and confirm it to protect your document. In the Add to Archive window, choose the
Archive format and add a password. Click OK to start the archiving and encryption process.
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5: How to Securely Password Protect an Excel File
If you want to password protect individual WordPress posts, pages, or WooCommerce products, you don't need any
third-party plugins. WordPress actually has a built-in function to help you accomplish this.

This document provides instructions for Acrobat DC and Acrobat Password security basics Note: You can
limit access to a PDF by setting passwords and by restricting certain features, such as printing and editing.
However, you cannot prevent saving copies of a PDF. The copies have the same restrictions as the original
PDF. Two types of passwords are available: Document open password A Document Open password also
known as a user password requires a user to type a password to open the PDF. Permissions password A
permissions password also known as a master password requires a password to change permission settings.
Using a permissions password, you can restrict printing, editing, and copying content in the PDF. If the PDF is
secured with both types of passwords, it can be opened with either password. However, only the permissions
password allows the user to change the restricted features. Because of the added security, setting both types of
passwords is often beneficial. You cannot add passwords to a signed or certified document. If you receive a
prompt, click Yes to change the security. For each keystroke, the password strength meter evaluates your
password and indicates the password strength. Options control compatibility with previous versions and type
of encryption The Compatibility option you choose determines the type of encryption used. Select an
encryption option: Encrypt All Document Contents Encrypts the document and the document metadata. If this
option is selected, search engines cannot access the document metadata. Encrypt All Document Contents
Except Metadata Encrypts the contents of a document but still allows search engines access to the document
metadata. You can use a search tool that takes advantage of XMP metadata. Encrypt Only File Attachments
Requires a password to open file attachments. Users can open the document without a password. Use this
option to create security envelopes. At the prompt to confirm the password, retype the appropriate password in
the box and click OK. The Restrict Editing option prohibits users from editing text, moving objects, or adding
form fields. Users can still fill in form fields, sign, or add comments. Type the password in the corresponding
field. Restrict printing, editing, and copying You can prevent users from printing, editing, or copying content
in a PDF. You can set the restrictions you want to apply to the PDF. Users cannot change these restrictions
unless you give them password. To open a restricted PDF in these applications, the user must enter the
permissions password. If you forget a password, you cannot recover it from the PDF. All Adobe products
enforce the restrictions set by the permissions password. However, if third-party products do not support these
settings, document recipients are able to bypass some or all of the restrictions you set. Password Security Settings let you restrict printing, editing, and copying Select what the user can print from the Printing Allowed
menu: None Prevents users from printing the document. Printing may be slower because each page is printed
as a bitmap image. High Resolution Lets users print at any resolution, directing high-quality vector output to
PostScript and other printers that support advanced high-quality printing features. Select what the user can
change from the Changes Allowed menu: None Prevents users from making any changes to the document that
are listed in the Changes Allowed menu, such as filling in form fields and adding comments. Inserting,
Deleting, And Rotating Pages Lets users insert, delete, and rotate pages, and create bookmarks and
thumbnails. Any Except Extracting Pages Lets users edit the document, create and fill in form fields, and add
comments and digital signatures. Choose any of the following options: Select an Acrobat version from the
Compatibility menu. The Compatibility option you choose determines the type of encryption used. Select what
you want to encrypt: Remove password security You can remove security from an open PDF if you have the
permissions to do so. If the PDF is secured with a server-based security policy, only the policy author or a
server administrator can change it. Your options vary depending on the type of password security attached to
the document:
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6: How To Password Protect a Folder in Windows 10
If you need something a little more bulletproof than the above, we recommend creating a password-protected file
container with VeraCrypt. It takes a few more steps, but it's still quite easy, and doesn't require you to be super
tech-savvy.

Less A password can be set for an Outlook Data File. When a password is used, a password prompt appears
when Outlook starts or when the file is first opened within an Outlook session. For a better way to restrict
access to your data, create a password-protected Windows user account for any person who uses the computer.
For more information, see Windows Help and Support. Your network password is used to access your
Exchange account and information. Use strong, case-sensitive, passwords that include a mix of a minimum of
eight uppercase and lowercase letters, numbers, and symbols such as Y6dh! A longer and more complex
password helps improve password protection. Click OK to set the password. Keep any password you write
down in a secure location, away from the information that it helps protect. If your Microsoft Windows user
account is password protected, and no other person has access to your Windows user account, you can select
the Save this password in your password list check box after you verify your new password. When you set an
Outlook Data File. Set or change the password for a. Each person who uses the same computer can have their
email delivered to a separate personal folder, each of which can have a password set. On the Data Files tab,
click the Personal Folders file. Click the Change password button. This button does not appear if your email
account runs on Microsoft Exchange. Your Outlook folders are already protected by your Exchange password.
In the New password box, type your new password. The password can be up to 15 characters long and
case-sensitive. Use strong passwords that combine uppercase and lowercase letters, numbers, and symbols.
Passwords should be 8 or more characters in length. A pass phrase that uses 14 or more characters is better. It
is critical that you remember your password. If you forget your password, Microsoft cannot retrieve it. Store
the passwords that you write down in a secure place away from the information that they help protect. In the
Verify password box, type your new password again. Anyone with access to the computer could potentially
open your. If your Windows user account is password protected, and no other user has access to the computer,
you can select the Save this password in your password list check box if you want to avoid entering your
password each time you need to use the. Click OK twice, and then click Close. Best practices and tips for
passwords There is no logon password for the Outlook program itself. The password you set with the
instructions here protects your personal data that is used in Outlook, but will not prevent people from using
Outlook or help secure data against hackers. Your Microsoft account and password that you use to log on to
Windows helps make sure that other users cannot access your files, not only in Outlook but all files that you
create and save in programs running on Windows. If you are running Outlook through Microsoft Exchange common in business environments and rare for personal or home e-mail - you do not need to set a password
for your Outlook data. Protection of your Outlook data is already managed by Microsoft Exchange. When you
set a. You cannot set a password for individual folders within the.
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7: How to Password Protect a Folder in Windows
The tool comes with both paid and free versions, however, as far as password protection is concerned, you can get that
in free version too. The tool is created by PDFMate that is also responsible for many other PDF tools.

Mon, 23 May, at 6: You can rename it to any name you want. This will bring up a script in a new window or
tab. You can leave all fields blank. A new row for version 1 will appear. You will now be shown a
confirmation that you app has been deployed as a web app. Now close this window and come back to the
spreadsheet tab or window. All the above steps are one time only. You have now fully setup your password
protected document. Now you can add what ever you want to store securely into the document. Just make sure
you leave the first two coloured rows intact. You will be asked to enter a password. Once done, this will
scramble the content each cell in the document. Now your data is fully password protected and nobody can
read it without having the password you have set. This password is not your Google account password, but
any password you can choose. You will be again asked for the password giving which it will decrypt and bring
back the cell contents which you can read or edit. This works well if you are opening the spreadsheet in a PC.
This URL gets created and added once you deploy the web app in Step 4 above. On loading the URL will
show a web page where you can enter your password to encrypt or decrypt the document. And as always, the
script is your local copy and runs entirely in your Google account. Nobody else has access to anything
including the password you set. On clicking the encrypt menu, the script checks the password with what you
have set. Only if it matches, the contents of the Spreadsheet is read and text in each cell is obfuscated. On
clicking Decrypt, the same algorithm converts the obfuscated text back to the original text if the password
matches. This may not be the most secure method of securing your data and should only be used to prevent
casual viewing of your data, it probably will not defeat a dedicated hacker.
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8: How to Password Protect a Microsoft Word Document: 14 Steps
Open the Word document, click on File then Info then Protect Document then Encrypt with Password, and then you
enter the password to the text box to set a password on it. Thanks! Yes No.

This is often used when a worksheet contains formulas that make calculations based on some data entry. Here,
those formulas need to be protected from changes whether unintentional or otherwise. Unlock all cells in the
worksheet Before protecting any cells in Excel, you must follow a simple procedure. This procedure unlocks
all the cells of your worksheet. But, Excel locks all the cells by default. So, this will always be your first step
to protecting cells with formulas. Then right click and chose Find Format Cells in the resulting context menu.
Find the Protection tab on the resulting Format Cells dialog box and uncheck the box next to Locked. Select
the formulas you want to lock Now you have unlocked the worksheet. Next, click on Go To Special. With the
Go To Special dialog box visible, select the radio button next to Formulas. Make sure all the boxes underneath
it are checked. Click OK and then notice that all cells with formulas will be highlighted. Now right click on
the highlighted cells and click on Format Cells in the context menu. In the resulting Format Cells dialog box
that appears, click on the Protection tab. Check the Locked box that we unchecked in the previous step where
we unlocked all the cells on the worksheet. Here you can set a password. For now, we will just leave it blank
and click OK. Check the protection of your cells with formulas. Need to add more formulas? And do they
need to be protected too? Simply unprotect your worksheet and then proceed to add the formulas. Then
reselect the range of cells with the formulas you want to protect. Make sure to include the new cells and follow
the same procedure. Now you have protected the cells in your worksheet with formulas. No users will be able
to delete, overwrite, or move those cells without unprotecting the sheet. Kasper Langmann, Co-founder of
Spreadsheeto How to hide formulas You might find it adequate to protect cells with formulas from changes.
However, any user can still view the formula contents of those cells in the formula bar. Do you want to hide
the formulas from other users for proprietary reasons? This is simple to do. It only requires a few more steps
built into the process of protecting cells. Kasper Langmann, Co-founder of Spreadsheeto Now select the range
of cells with formulas that you want to not only protect but also hide the formulas in. Then right click and
select Format Cells to bring up the Format Cells dialog box. This time, make sure there that not only the box
next to Locked is checked, but also the box next to Hidden. Now when you click on a protected cell, the
formula is no longer shown in the formula bar. And there you have it: Your formula cells are not only
protected from moves or changes, they are also private. Now you want to do some additional work to your
worksheet. For instance, you want to edit your formulas or add some new ones. Simply, turn off or remove the
protection and unhide your formulas. This is a very simple procedure and we have already covered it
somewhat. Now select the range of cells that you want to unlock and unhide. Right click and select Format
Cells. When we say workbook, what we are referring to is the Excel file itself. A workbook is an entire file
containing all the worksheets different tabs in the file. You should note that Excel offers file-level protection
as well as workbook-level protection. These are two very different levels of protection but do not let this
confuse you. File-level protection for your workbook The highest level of protection that Excel offers is
file-level protection. If you want to allow only certain users to even open the file, this is the level of protection
you want to use. Locking access to your Excel file with a password encrypts the file. On the Encrypt
Document dialog box, type in a password and click OK. You will be prompted to re-enter the password and
click OK. When you save the file and anyone attempts to open it, they will be prompted for a password.
Anyone without the password is restricted from opening the file. To reverse this encryption, simply repeat the
previous process. Delete the password from the input box for password and click OK. This was achieved by
encrypting and restricting access to the file. Now we will turn to workbook-level protection with a password.
This level of protection does not restrict users from opening the file. It provides an entirely different level of
protection. Here users cannot delete, move, hide or rename any of the worksheets in your workbook file. The
first thing you need to do is click on Protect Workbook in the Changes group on the Review tab. Check the
box next to Structure. Note that the password text box indicates that a password is optional. Once you have
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clicked OK, try to add, delete, move, or rename a worksheet. This is not to be confused with file-level or
worksheet level protection. Because users could still open the file and make changes to the contents of the
worksheets themselves. Kasper Langmann, Co-founder of Spreadsheeto Bear in mind that you can protect
your workbook structure with a password or without. Password protection provides the workbook owner you
more control over who can make changes to the structure of your workbook. Remember, they can simply
unprotect the workbook if they wanted to. So, what exactly is workbook-level protection? In the previous
section on how to password protect your workbook, we mentioned workbook structure. This refers to the
composition of the worksheets within the Excel file. They can view and even change contents within the
worksheets. But, they cannot change anything at the worksheet or workbook structure level. Unprotect an
Excel workbook All it takes to unprotect a workbook not protected with a password is to click on Protect
Workbook. This button is in the Changes group on the Review tab. The dark gray background indicates that
the workbook is currently protected. By doing this, you will unselect or deactivate the workbook protection.
This is also displayed when Protect Workbook is no longer highlighted on the Ribbon. To unprotect a
workbook that is password protected, you follow the same procedure. But, now you will be prompted for the
password. Kasper Langmann, Co-founder of Spreadsheeto Once you supply the correct password, Excel will
remove the workbook protection. How to retrieve forgotten password for a protected sheet? What if you forget
or lose your password for a protected file, workbook, or worksheet? Always make sure to write your
passwords down in some secure fashion in case you were to forget them. You will be out of luck if you lose or
forget your password to open your file. But, if we are talking about workbook or worksheet level of protection,
there is hope! The following VBA code can be found with a simple Google search. However, we will go ahead
and cover the details of how to put it to use here. Follow these directions step-by-step. Then, you will be
unlocking your password protected sheets and workbooks in no time! In the Project window on the left, find
the worksheet listed that you have forgotten your password for. Double click on it. Copy and paste the
following code into the General Declarations window that now appears: Next End Sub Your page should now
look like the following figure: Once the macro runs, a message box with a password should appear. And there
you have it! Simply use this password to unprotect your sheets or workbooks.
9: How to Password Protect and Encrypt a Flash Drive: 5 Easy Methods
With the Publish Sensitive Information action in Acrobat Pro DC, you'll be guided through a series of steps to redact,
password-protect, and save with edit and copy restrictions applied automatically.
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